Using Access97

A database is a collection of data organized in such a way so as to provide easy access, retrieval, and use of that data. A database management system (DBMS) is computer software that allows you to create a database, add information to a database, modify and delete information, sort and retrieve information, and to create reports using the information in the database. A database can be fairly simple, consisting merely of a list of names, addresses, and phone numbers, or extremely complex consisting of many tables of information. Access97 is a database management system that considers a database to be a collection of one or more tables.

Typically, database contains records of information. A record may, for example, consist of first name, last name, street address, city, state, and zip code. Each record contains fields. Fields are the specific parts of a record--the first name field, the last name field, the street address field, etc. In Access, such records are stored in tables. A table is a collection of information organized in rows, with each row of information corresponding to a record, and each column in the table a field. For example, consider the table below. Each row in this table represents a student record. The columns in the table represent the fields of ID, FIRST NAME, LAST NAME, and GPA, respectively:

<table>
<thead>
<tr>
<th>ID</th>
<th>FIRST NAME</th>
<th>LAST NAME</th>
<th>GPA</th>
</tr>
</thead>
<tbody>
<tr>
<td>123-45-6789</td>
<td>Samuel</td>
<td>Adams</td>
<td>3.45</td>
</tr>
<tr>
<td>987-65-4321</td>
<td>Teddy</td>
<td>Bare</td>
<td>2.98</td>
</tr>
<tr>
<td>332-44-5768</td>
<td>Barbie</td>
<td>Dahl</td>
<td>3.23</td>
</tr>
<tr>
<td>443-22-1212</td>
<td>John</td>
<td>Doe</td>
<td>2.99</td>
</tr>
<tr>
<td>555-55-5555</td>
<td>Ella</td>
<td>Vader</td>
<td>3.50</td>
</tr>
</tbody>
</table>

This introduction to Access will go over the creation of relatively simple tables, and does not go into detail about the creation of complex databases with multiple tables. Multiple tables that have a relationship between fields in the various tables (such as a database for a business containing the home state of a distributor with the home state of a client) is called a relational database, and is one of the strengths of Access. This handout is meant as a basic introduction to the program; you should consult a book on Access for more detailed information.

CREATING A NEW DATABASE

Open Access by clicking on the Start button on the task bar in Windows 95/98, then click Programs, and finally on Access97. The first screen you see will give you the choice of opening an existing database or creating a blank one. Since you want to start a new database, click on the choice Blank Database, as shown on the screen shot below:
After clicking **OK**, you will see that following screen:

Give your database an appropriate name in the box, then click the **Create** button.
CREATING A NEW TABLE

After naming your database, you will get the screen below. Since a database in Access is a collection of one or more tables, your first task will be to create a table. For each table, you will have to define the table structure. It is only after defining this structure that you will be able to actually begin adding data.

After clicking New, Access will prompt you for how you want to start designing your new table. It is best to go with the Design View, since this gives you the greatest flexibility in designing your new table:

After clicking OK, you will see the screen depicted on the following page.
SPECIFYING A TABLE STRUCTURE

You will now begin to define the fields in the table. In the table design view, as shown above, each specific field is in a row of the table. Each row contains three elements, with the first two being the most important: field name, data type, and description.

- With the cursor (insertion point) in the top row in the Field Name column, type the name of your first field in your table.
- Press the Tab key on your keyboard to move the cursor over to the Data Type column, or click in the column yourself with the mouse.
- Click the down arrow in the Data Type column to select a data type. There are nine data types to choose from (these are discussed later). Click the one wish to select.
- Note that as soon as you select a data type, the Field Properties box at the bottom of the screen is available for input. Make sure you are in the General section of Field Properties (the default). The one element you may want to take advantage of here is Field Size. Type in the maximum length of this field. (Be careful not to make it too short!)
- Press Tab again and type in an optional description, which will appear in the Status Bar portion of your screen when you begin in input data.
- Press Tab again or click the left mouse button in the first column (Field Name) of the next field to be defined. Continue entering each field this way until finished with your table design.
Here is what the screen looks like when you are inputting your field definitions:

**Data Types**

The data type you select for the field is up to you, and depends how you plan on using the field for other Access features such as reports or queries. For example, notice that the ID number we have in our database so far was made a *text* field, even though it contains all numbers. Why? We don't plan on manipulating that data in any way. On the other hand, our GPA field will be made a *number* field, since it is possible that for a query, we may want to limit a search to those students with GPAs of 3.25 or higher--or perhaps to even find an average of all GPAs.

The following page lists the data types available within Access.
<table>
<thead>
<tr>
<th>Data Type</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Plain text, including letters, numbers, etc. The maximum field length is 255 characters.</td>
</tr>
<tr>
<td>Memo</td>
<td>Also text, with a maximum length of 64,000 characters. Be wary of using--it can take up a lot of disk space!</td>
</tr>
<tr>
<td>Number</td>
<td>Numbers only--no text. Check the help available within the Field Size in the Field Properties.</td>
</tr>
<tr>
<td>Date/Time</td>
<td>A date or time, with several options in format (short date, long date, etc.) available via a pull-down menu that will be displayed under Format in the Field Properties.</td>
</tr>
<tr>
<td>Currency</td>
<td>Numbers will be automatically converted to currency. Check the Format box in the Field Properties for options.</td>
</tr>
<tr>
<td>AutoNumber</td>
<td>Access automatically fills in a consecutive number for each record added. Good for those times when you want a Primary Key (see below) but can't think of an existing field to assign one to.</td>
</tr>
<tr>
<td>Yes/No</td>
<td>For a field that requires a Yes/No, True/False, or On/Off answer.</td>
</tr>
<tr>
<td>OLE Object</td>
<td>A link to a file or database--too advanced for the purposes of this handout!</td>
</tr>
<tr>
<td>Hyperlink</td>
<td>To create a link to a file on the Web; your database must on a computer with constant connection to the World Wide Web for this to work.</td>
</tr>
<tr>
<td>Lookup Wizard</td>
<td>Allows one to choose values listed from another table--too advanced for the purposes of this handout.</td>
</tr>
</tbody>
</table>

**Primary Key**

Before saving your table structure, it is generally a good idea to assign a Primary Key to a field. A field that contains unique information about an individual (for example, a Social Security Number) is a good candidate for a primary key. A primary key field means you will not be able to have records with duplicate entries in that field. A primary key is not a requirement, though Access will ask you if you want one before you save your table. To assign a primary key, place your cursor anywhere in the row representing the field you want to make the primary key, and click on the Primary Key button on the table design toolbar:

**Saving Your Table Structure**

Once the table structure has been defined, the next step is to save the table within the database. (Keep in mind a single database can have many tables.) To save a table, click on the File pull-down menu, then Save, or just click on the floppy disk icon on the toolbar: You will then see the following dialog box. After typing in a name, just click OK:
ADDING RECORDS AND EDITING RECORDS IN A TABLE

Once the fields for your table have been defined, you are ready to put actual records within the table. In order to add records to a table, the table must be open. First, close the design view (if it isn't already), so that you're back to the main database window in Access:

When your table is open, you will be in what is called the **Datasheet View**, and your table will be ready to have records added to it:

- Highlight with your mouse the name of the table you want to open, and click the **Open** button, or just double-click directly on the name of the table to open it.
- Press TAB key on the keyboard to move insertion point through the fields after you've typed your data, or click within the field the mouse.

If you want to go back to the Design View and work on your Field Properties, add a field, etc., click on **Design** instead of **Open**.
To add a new record to your table in the Datasheet View, just click on the (Go to last record) button near the status bar on the bottom of the screen. To modify information already in your table, just click in the appropriate box and enter the new value. Unlike other Office97 applications, Access saves new record information automatically—you do not even have to click the Save button on the toolbar. However, if you change anything in the database structure in the Design View (length of fields, a new field, etc.) you must save it!

**Finding a Record**

If your table gets big (and most active database tables will!) and you need to find a specific record to make changes to it, there are several ways to do this, many beyond the scope of this document. One quick way, however, is to simply click on the Find button ( ) in the toolbar and type in the text you are looking for. Access will take you to the record(s) that match your criteria:

**DELETING RECORDS FROM A TABLE**

To delete a record, you must find the exact record you wish to delete. (You may want to use the Find feature outlined above.) Once you've found it, click in the left-most column of the table. When done, all of the fields in that record should be highlighted, as shown below. Once they are highlighted click on the Delete button in the toolbar.

**WARNING:** once you delete a record, your action can not be "undone"!
MODIFYING A TABLE

It is possible to modify a previously saved table's structure, though you should be aware that there could be several consequences. If you decide to add a field, you will have to go through each record in your database table and add the data for your new field. If you chance the field size property, you may lose data if you shorten it too much (though Access gives you fair warning first).

To change the design of a table, when you first open your database, make sure the Tables tab is clicked in the main database windows, and click the Design button (see screen shot on page 7, above). If you are already in the table Datasheet View, click the View button (see screen shot on page 7) to go into the Design View. Alternatively, if you are in the Design View and want to go back to the Datasheet View, you may also click the View button, which will have a different icon this time:

![Microsoft Access - [Students : Table]](image)

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Text</td>
<td>Student ID Number (Social Security Number)</td>
</tr>
<tr>
<td>First Name</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Last Name</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>GPA</td>
<td>Number</td>
<td></td>
</tr>
</tbody>
</table>

PRINTING A DATABASE TABLE

To print a database table, just click on the File pull-down menu, then Print, as you would for any other Office97 application. Creating a Report, discussed later, provides a more eye-pleasing output, however. You may want to click the Print Preview button on the toolbar ( ) to see how your table will look before printing it.

PRINTING THE TABLE STRUCTURE

There may be times you want to view the structure of your database all at once on a printout without having to actually go into the database. Access allows this through the use of tool called the Documenter. To get to the Documenter, you must first close the tables you are editing and be at the main database window. From here, you want to click the Tools pull-down menu, then Analyze, and finally Documenter:
Once you do this, you will be presented with the following dialog box:

After clicking next to the table name you want documented, before going any further (and to avoid multi-paged printouts, depending on the part of the database you are documenting), you should click on the **Options** box in this dialog box to pick out the parts you want a printout for:
After you've made your selections, click OK. You will return to the previous dialog box (shown on previous page). At this point, you can click OK and will be shown a preview of your printout. You may printout this screen using the usual File . . . Print . . . command.

CREATING A FORM TO INPUT DATA

If you ever input records into Access while working in an office, you will likely do so through a form. Forms typically provide a much easier layout for inputting records than the Datasheet view does. This document can not go into too much detail on creating forms in Access, but we can provide a quick way to create at least a rudimentary form for data input.

From the main Access database window, make sure you first click on the Forms tab on the top, as shown on the following page, and then click on the New button:
This will lead to the following dialog box:

From the above box, you should click on the **Form Wizard** option, then click **OK**. The Form Wizard will guide you step-by-step through the form creation process. After clicking **OK**, you'll see the next box, which prompts you for which fields you want to include on the form. You can select them one-by-one by highlighting the name of the field and then clicking the > button, but if you want all fields on the form (and you likely will), just click on the >> button to move them all over at once:
Once you’ve selected your fields, click the **Next** button.

You are next asked to select the appearance of your form. Keep your eye on the window on the right for an idea of the layout. (The **Tabular** and **Datasheet** views somewhat resemble the **Datasheet View** of the table, while columnar forms are arranged vertically).
You are next prompted to select the visual background and appearance of your form:

Finally, you will be asked to name your form. By default, Access will have the same name as your table already in the box. You may want to consider giving it a slightly different name, since there may be times while using Access that you will have to select a table, query, or form name from a drop-down menu listing, and too many elements in Access with the same name can be confusing.
Access will then display the completed form. You may now add records using the form rather than the table Datasheet View. (There are many, many more possibilities in Access with designing a form than this overview has the chance to give you. Consult a book on Access for more information.)

QUERIES

As your database gets bigger, it gets more difficult to find a specific record or records that match certain criteria. You may, for example, want to know the names of all students who have a grade point average of 3.0 or above. When you ask a question of Access or any other database, that question is called a query. To find an answer to a question in a database, you must first create a query, and then run the query. Queries can be saved, so that if you have to keep asking the database the same question, you can keep running the query to get the results—even if you've added hundreds of records to the database after you first constructed the query.

Creating a Query

To create a new query, make sure the main database window is open, and from there, click on the Query tab, then click New:
In the window that follows, make sure **Design View** is highlighted, then click **OK**:

![New Query window]

Next, you will be asked which table(s) to have in your query design. Highlight the table name, then click **Add**. You’ll notice a table appearing in the upper part of the query design window. Since you only have one table, just click the **Close** button after adding your table.

![Query design window]

After adding a table, it will appear in this section of your query design.

Click the **Close** button when finished.
Using the Query Window

With the query design on the screen, you may find it easier to maximize the window. Also, you can use your mouse to move the upper portion of the window higher or lower in relation to the lower portion. Also, click and drag over the edge of the table window in the upper portion if you can't see all of the fields in the table. You will need to be referring to these fields when constructing your queries.

The purpose of the query design window is to specify the fields you want to run a query on. There are a few ways to do this:

- Double-click on the name of any field from the table window in the upper part of the window, or
- Click on the name of any field, then while holding down the left mouse button, drag it down into the lower window, or
- Click in the Field row on the bottom half. A down arrow will be displayed. You can click on this down arrow to select a field.

There will be specific query examples discussed below. You will also notice there is a row labeled Show in the lower window. If the Show box has an check mark (✓) in it, it means the field will be displayed in your resulting query. If there is check mark, the field will not be displayed. For example, you may want a listing of all students with GPA's of 3.0 or higher. You will have to specify the First Name, Last Name, and GPA fields in the lower window to run the query, but you may only want to show the first name and last name, and not the actual GPA in your results:
The query above shows that we want to show the first name and last name of students. We want only those students listed with a GPA of 3.0 or higher, so in the Criteria row we typed in >=3. When we actually run the query, however, we don't need the actual GPA displayed, so we unchecked the Show box in the GPA column. Now, to actually run the query, we need only click on the exclamation point button in the toolbar, which will give us the following result:

This result (called a dynaset) shows first name and last name, but not the GPA. Of the ten students in our database, these are all of those with GPAs of 3.0 or higher. If you didn't get the results you expected, you can go back to the design view by clicking the view button.
QUERY EXAMPLES

There are many types of queries that can be run in Access. This section will outline a few.

Greater Than or Less Than

You may use the following in the Criteria row of an Access query to match numbers or letters greater than or less than a specific criteria:

<table>
<thead>
<tr>
<th>&gt; greater than</th>
<th>&lt; less than</th>
<th>= equal to</th>
<th>&lt;&gt; not equal to</th>
<th>&gt;= greater than or equal to</th>
<th>&lt;= less than or equal to</th>
</tr>
</thead>
</table>

This works with any date fields you may have, too. So, to find all students whose last names begin with a letter greater than the letter L and who have GPAs of less than 3.25, you would enter:

Using Wildcards

The asterisk (*) is the wildcard symbol in Access. It is handy if you are unsure of the exact spelling of a word in your database or simply want everything starting with a certain character string. To retrieve all students whose last name begins with the letter D, for example, you would enter d* in the Criteria field (upper case letters are not necessary):
Logical Operators

You may use the logical operators AND, OR, or NOT within queries, though Access does some of this by default in the query design window. For example, each column in the query is an implied AND--you want the contents of one field AND the contents of another to appear in the results. Our previous example used a logical AND--we wanted students with last names after the letter L, AND we wanted to limit the results to those with a GPA less than 3.25.

The logical operator OR may be typed directly between two criteria in the same cell or used the next line down in a column (note from our previous screen shots that the Criteria row has a row labeled OR just beneath it). When using OR, it means you want one OR the other to appear in the results. So, if we want students whose first name is Barbie or Boris, we can enter it as:

<table>
<thead>
<tr>
<th>Field: First Name</th>
<th>Last Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table: Students</td>
<td>Students</td>
</tr>
<tr>
<td>Sort:</td>
<td></td>
</tr>
<tr>
<td>Show:</td>
<td></td>
</tr>
<tr>
<td>Criteria:</td>
<td></td>
</tr>
<tr>
<td>or:</td>
<td></td>
</tr>
<tr>
<td>&quot;barbie&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;boris&quot;</td>
<td></td>
</tr>
</tbody>
</table>

The same search can be performed by typing an OR between the two terms in the same Criteria row. In fact, this method is preferable for more complex queries with several columns, since otherwise Access may return one set of results matching the "barbie" criteria, and another set matching the "boris" criteria. (Remember, there is an implied AND between columns!)

<table>
<thead>
<tr>
<th>Field: First Name</th>
<th>Last Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table: Students</td>
<td>Students</td>
</tr>
<tr>
<td>Sort:</td>
<td></td>
</tr>
<tr>
<td>Show:</td>
<td></td>
</tr>
<tr>
<td>Criteria:</td>
<td></td>
</tr>
<tr>
<td>or:</td>
<td></td>
</tr>
<tr>
<td>&quot;barbie&quot; Or &quot;boris&quot;</td>
<td></td>
</tr>
</tbody>
</table>

The NOT operator is used by placing the word NOT before the criteria you don't want to appear in your query. If you want a list of all students, but not those whose last name begins with the letter D, you would enter not d* in the Criteria row under Last Name. (Access automatically adds the word Like as it does for all wildcard queries with the asterisk):

<table>
<thead>
<tr>
<th>Field: First Name</th>
<th>Last Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table: Students</td>
<td>Students</td>
</tr>
<tr>
<td>Sort:</td>
<td></td>
</tr>
<tr>
<td>Show:</td>
<td></td>
</tr>
<tr>
<td>Criteria:</td>
<td></td>
</tr>
<tr>
<td>or:</td>
<td></td>
</tr>
<tr>
<td>Not Like &quot;d*&quot;</td>
<td></td>
</tr>
</tbody>
</table>
BETWEEN Operator

The BETWEEN logical operator is good for searching between two values, inclusive. For example, you may want to search for all students with a GPA between 2.00 and 2.99, inclusive. In the GPA field, you should enter **between 2.00 and 2.99** in the **Criteria** field:

(Note that *Access* just strips off the zeroes following the decimals). The same query could have been constructed using the \( \geq \) sign along with the \( \leq \) sign. This is just one example of how the same query can be constructed several different ways:

Either query gets the same results when the **Run** button is clicked:
Sums, Averages, Etc.

Clicking on the sigma key on the toolbar in the *Access* query design window (Σ) will bring up a new row called *Total* in the query grid. This allows you to do some basic arithmetic operations, such as summing certain fields, giving the average, etc. Clicking the down arrow within this row will give you a list of the capabilities. For example, to compute the average GPA among the students in the database, you would include the GPA field in your query, and select *Avg* after clicking the drop-down arrow:

| Field: GPA | Total: Avg |
| Table: Students | Sort: |
| Show: |

After running the query, the result will simply be the number:

![Microsoft Access - [Query1 : S]](image)

Be careful not to add fields that can't be displayed together when doing a search with the *Total* row. You cannot, for example, include the Last Name field in the above query, because all you want is an average. If you try, *Access* will simply list all of the last names in your database, and not bother trying to calculate the average at all.

You will find, when combining certain fields you wish to total, that you may have to specify the term *EXPRESSION* in the *Total* row to get accurate results for your query. For example, say you want the average GPA of all students with last names greater than the letter *L*. Here is the way you may want to start your query:

| Field: Last Name | GPA |
| Table: Students | Students |
| Total: Avg | |
| Sort: |
| Show: >"L" |

This looks logical, but, *Access* will in fact give you query results that look like this:
Instead of displaying the average GPA for the students whose last name is greater than L, *Access* instead simply lists them. To further confuse matters, because there happens to be two students with the last name Rabbit, *their* GPA is averaged.

Basically, if combining a **Total** row with other fields, depending on your criteria you may have to specify the term **EXPRESSION** within the **Total** row in the other columns. (Think of it this way: you want the average GPA of all students higher than the last name "L," but you are including this as part of your total *expression*.) Also, you will want to **uncheck** the **Show** box in the Last Name column, since you do not want the names to show on the result. Here is the way the correct query design should look:

Now, when you run it, you get just one average—as you should:
Renaming a Field

Just because you named a field one way in your table design doesn't mean that's the way it has to appear in query results. To display a field in a query using a different name than the one you originally gave it, click in the field name in the bottom portion of your query design, and simply type the name you want to give you field in front of the original name, followed by a colon (:) with no spaces separating your name from the original name. The format is:

```
NEW FIELD NAME:OLD FIELD NAME
```

So, to rename the field we originally called **ID** to one called **Soc Security Number**, here is what our query design would look like:

You can type directly into any box in the query design table, but you can also press **Shift-F2** to bring up a "zoom" window once your cursor is in the correct field name in the query, which gives you a bigger space to work in. Just make sure to keep your original field name after the colon! Here is the result of this query with the renamed field:
SAVING A QUERY

After you've designed a query and run it, and everything looks like it works, you should immediately save it. (After all, why do it all over again?) To save a query, in either the design view or the results (dynaset) view, click on the File pull-down menu, then Save if it's the first time you're saving the query, or Save As if you made modifications to it but don't want to overwrite your first version. In the resulting screen, you can give your query a name. (By default, Access names them Query1, Query2, etc., but you can change it):

RUNNING A SAVED QUERY

Once you've saved a query, you can run it at any time from the main database window by clicking the Open button after highlighting the name of the query you wish to run:
REPORTS

Reports are the means by which you produce nicely formatted and labeled listings of your database information. To create a report in Access, click on the Reports tab in the main database window, then New:

From the following New Report dialog box, select the Report Wizard in the top half of the box. Then, click the down arrow in the lower window, and select the table or the query you want to base your report from. (Yes, query results can be the basis of reports, too--not just your data tables.)

The next box of the Report Wizard looks very similar to the Forms Wizard we saw earlier. You are to select which field(s) you want to appear in your report by selecting the field names on the left size of the window and moving them over to the right. You can click the > button to move the fields over one at a time, or the >> button to move them all over.
After you've selected the fields, click the **Next** button, and you'll be asked if you want to add any Grouping Levels. This is not necessary, but it *does* enable subtotals to be generated in the report for each group. For example, if you wanted the average GPA by state of residence, you should add a grouping level of state:
Once selected, the dialog box will look like this:

![Diagram of Report Wizard dialog box]

Click the **Next** button, and you'll see a screen prompting you for sorting information. Here, we are specifying that within each state, we want names to appear in alphabetical (A-Z) order by last name, and then within any last names that match in alphabetical order by first name:

![Diagram of Report Wizard sorting screen]
Notice that the previous dialog box has a button labeled **Summary Options**. This is available only if you decided to add a grouping level earlier, and is good for generating various subtotals within your report. If you choose to click **Summary Options**, here is what you’ll see:

Since we want the average GPA for each state to be generated, we've clicked in the **Average** box. After clicking **OK**, we return to the sorting order box we saw previously, and can click the **Next** button to go on, when we are asked about our layout:

**Report Wizard**

- **Layout**: Stepped, Blocks, Outline 1, Outline 2, Align Left 1, Align Left 2
- **Orientation**: Portrait, Landscape

*With most Access reports, it’s safest to select Landscape orientation!*

Keep your eye on the sample layout here when choosing which layout you want.
Generally, you want to select **Landscape** orientation since *Access* reports often contain many fields. Even then, you won't always fit everything onto one page. After selecting the printing orientation, you have one last appearance question to answer:

Here, you have various options to select the general appearance, with examples shown at the left. Again, after you've selected one, click the **Next** button, and you're at the final step:
You can type whatever you want to as the Report name. This is how it will appear from now on under the **Reports** tab of the main database window. Finally, click **Finish**, and you'll see your report in the Preview mode:

Note how—as we specified when constructing the report with the Report Wizard—that our students are grouped by state, and within each state they are in alphabetical order by last name, and then by first name. Also note that the average GPA appears calculated for each state, as we specified in the Summary Options section.

You can make changes to virtually everything on this report by clicking the **View ( )** button on the toolbar. From there, you can select the **View** pull-down menu, then **Toolbox** to insert additional fields, labels, etc. You can also create other calculated fields within your report by creating text box and changing its **properties**. It is beyond the scope of this introduction to give details, but most books on *Access97* will give you help on this.
OPENING A DATABASE

Whenever you want to add or modify an existing database, whenever you open Access97 and get to the first screen, click the button to Open an Existing Database.

You will see the last four databases you worked in listed. Click on the database name you want, then click OK. If you don't see the one you want listed, click on the More Files… option, and you will see the conventional file open window that's used in any other Office97 program.

THE HELP FACILITY

Like every other Office97 program, Access has a variety of ways to find help. The most direct is clicking on the Help button on the toolbar:

This brings up the Office Assistant, where you can type keywords of questions into a box. A more conventional help facility is available by clicking on the Help pull-down menu, and clicking Contents and Index. Clicking on the Index tab gives you a list of topical help headings, while clicking on the Find tab allows you to search help screens by keyword.